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Disclaimer  

The contents of this document are subject to revision without notice. DEIF A/S shall have no liability for any 
error or damages of any kind resulting from the use of this document.  

The English version of this document is the original language, and always contains the most recent and up-
to-date information about the product. Translations might not be updated at the same time as the English 
version. DEIF A/S does not take responsibility for the accuracy of the translations. The English version 
always takes precedence if there is any discrepancy. 

 

 

Trademarks 

DEIF 
power in control 

DEIF and power in control are registered trademarks of DEIF A/S 

Silicon Labs® Silicon Labs is a registered trademark of Silicon Laboratories Inc. in the 
United States and other countries 

All trademarks mentioned in this manual are the properties of their respective owners. 

 

 

 

Copyright 

© Copyright DEIF A/S. All rights reserved. 
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1. Introduction 

This document describes how to mount, connect and perform initial start of the IMD at production. The 
initial start also includes upgrade of software and upload of parameters. It is assumed that a parameter 
file for the upload already exists. The manual described the standard way of installing the IMD.  

It is recommended to fill out the verification check list (document no. 4189360022), and keep it with the 
turbines documentation in order to document the verification of the system. 

It is possible to print this manual on a monochrome printer, though figures and illustrations are easier to 
understand if a colour printer is used.  

1.1 Conventions 

The following conventions are used in this document: 

Used in document Description 

Monotype font Used when describing a path or text input in a machine human interface 

 A yellow symbol illustrates hazard type (this symbol is an example for general 
hazard). There are different types such as electrical, chemical and so on. 

Danger! A signal word used to indicate an imminently hazardous situation, which if not 
avoided, will result in death or serious injury. (ISO 3864) 

Warning! A signal word used to indicate an imminently hazardous situation, which if not 
avoided, could result in death or serious injury. (ISO 3864) 

Caution! A signal word used to indicate a potentially hazardous situation, which if not 
avoided, could result in minor or moderate injury. (ISO 3864) 

 A blue symbol illustrates a need for mandatory action. In this example read 
instructions. Other types of blue symbols exist and always indicate mandatory 
action. 

 A symbol used to draw attention to extra information or an action that is not 
mandatory 

1.2 Referenced documents 

The following documents are referenced in this manual: 

Document no. Title 

4189360022 IMD 100 configuration and verification checklist 

 

Info 

The screen images in this manual are based on the noted IMD Manager version. The 
manual will not be revised if a new version of the IMD Manager is available, but has no 
practical impact on the tasks described in this manual. 
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2. Safety precautions 

 

Attention 

Company policy and local regulations regarding PPE must always be followed, regardless 
whether the PPE is shown in this manual or not. 

2.1 Mechanical work 

 

2.2 Electrical work 

 

 

 

 

Use eye, hand and hearing protection 

Use protection for eyes, hand and hearing, if the mounting holes for bolts and 
heat sink need to be made during production. 

 

Disconnect power 

Ensure that all power is disconnected when working with the IMD, except for during 
commissioning, testing and service. 

 

Danger! 

Risk of burns and electrical shock from short circuit, electrical arc and uninsulated wires. 

Live work is not permitted, except for during verification, commissioning, and service.  

Observe local regulation when working with electrical components. 

 

Danger! 

Risk of burns and electrical shock from short circuit, electrical arc and uninsulated wires. 

Commissioning and maintenance work on this device may only be carried out by a qualified 
electrician.  

When the IMD has been powered, there is a risk of stored energy even when the power is 
disconnected. Wait 5 minutes after the power is disconnected and verify zero energy 
according to company procedures on the outputs before performing any work. 
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Caution! 

Risk of electrical shock from touch current if the protective earth is removed when the IMD is 
energized. 

Do not remove the protective earth is removed when the IMD is energized.  

 

2.3 Thermal precautions 

 

 

 

 
Figure 1 Hot surface areas 

  

 

Info 

During operation, the IMD can reach high surface temperatures. The temperature levels 
depend on the ambient temperature inside and outside the cabinet.  

 

Warning! 

Risk of severe burns. 

The heat sink of the IMD can reach high temperature. 

Do not touch until the surface (see pos. 1 in 
Figure 1 on page 7) is cooled down. 

 

Caution! 

Risk of burns. 

The sides of the IMD can reach medium high temperature. 

Do not touch until the surface (see pos. 2 in  
Figure 1 on page 7) is cooled down. 

2 
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3. Avoiding damage to the IMD   

Certain situations may result in product damage and should therefore be avoided by observing the 
precautions described in this section. These situations are not likely to occur under normal use of the 
IMD, but might occur in the lab or during service.  

The situation list may not be comprehensive. Other, unknown situations that are not described in this 
section could occur.   

3.1 Connecting the safe energy 

Possible damage: Damage to internal power components. 

3.2 Switching mains ON and OFF 

Possible damage:  DC-link Pre-charge circuit damaged due to repeated MAINS ON and OFF 
operations 

 

How to avoid:  

If the MAINS connections are switched ON and OFF more than once, wait 60 seconds 
before switching ON after switch OFF. 

3.3 Overloading the ballast resistor 

Possible damage: Ballast circuit ((switch or resistor) damaged due to overload. 

 

How to avoid:  

• The ballast resistor value is adequate for the DC-link Vmax.  

• Never use single pulse longer than 1 s during safe energy test. 

• Wait 10 minutes (at 25ºC) if the IMD is restarted and the ballast resistor has been 
loaded (hot) 

3.4 Connecting the mains with overvoltage 

Possible damage: Total damage to the IMD. 

 

How to avoid:  

The mains supply must never exceed the range specified in the Data sheet. 

 

 

 

How to avoid:  

If the safe energy was disconnected from the SE terminals, the mains supply must be 
turned on before the safe energy is turned on. 
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4. Configuration and firmware update 

When the IMD is mounted and all electrical connection are made, the IMD needs to have the necessary 
parameters configured (customer specific), and possibly also firmware upgrade. The order of 
performing configuration and update does not matter.  

4.1 Firmware update 

There are two ways in which the firmware (FW) can be updated in the IMD: 

1. Update through the “Service” USB connector. 

2. Update through CANopen 

The FW update in this stage is done through the “Service” USB connector no matter which method is 
going to be used later on, however, there is a difference in the files that are loaded to the IMD and how 
these files are loaded. Select the appropriate method in this section. 

NOTE  It will always be possible to update the FW through the “Service” USB connector. It is just a 
matter of which files are used in the update. However, if the procedure for future Service USB 
connector update is used, it will not be possible to update the FW through CANopen, without 
performing the procedure for future CANopen update first. 

4.1.1 Updating firmware for future Service USB connector update method 

4.1.1.1 Prerequisites 

• A computer with Spectrum Digital SDFlash program installed (including V3.3 SDFlash serial patch 
for flash programming, September 5, 2008), (http://emulators.spectrumdigital.com/utilities/sdflash/) 

Typically, the necessary USB driver will be found automatically if the computer is on-line. Otherwise, 
go to Silicon Labs home page and download the latest driver for CP210x USB to UART Bridge 
(http://www.silabs.com/products/mcu/Pages/USBtoUARTBridgeVCPDrivers.aspx). 

• The computer must be connected to the IMD with USB cable (male type A to male type B). 

• Prepare the FW files for use: 

1. Copy the folder of the new FW. 

2. Paste the folder in the folder where other FW is located.  
If the FW files are located at their default location, go to myprojects folder in sdflash folder 

(where sdflash was installed) and paste the folder under myprojects. 

NOTE  The files can be located anywhere. It is possible to brows to the location and sdflash 
             remembers this location. 

3. Copy any of the .sdp files in the folder and paste it (the .sdp.  

4. Rename the .sdp file to the same name as the new FW folder: 

 

Info 

The links above were valid at the time when this manual was written. If the link does 
not work anymore, search for  “V3.3 SDFlash serial patch” or “CP210x USB 

to UART Bridge driver”. 

http://www.deifwindpower.com/
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4.1.1.2 Updating firmware – USB FW 

1. Before turning the power to the IMD ON (24 V DC if the IMD does not have built-in power supply, or 
400 V AC if it does have a built-in power supply), ensure that the RFE input is OFF to prevent the 
IMD from starting the motor unintentionally. 

2. Start the SDFlash if it is not started already. 

3. Set the IMD into programming mode by doing the following: 

a. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) off.  

b. Set the CAN ID switch to position 15. 

c. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) on. 
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4. Click File→Open Project… (1), select and select the .sdp file that belongs to the FW that should be 
installed (2) and click Open (3):

 

 
 

5. Skip this step if the used Com port is known. 
Open the “Device manager” in the computer’s “Settings” and determine which com port is used for 
the USB connection (the look and name of the device manager may differ depending on the 
operating system). Only Com1, Com2, Com3, and Com4 can be used with the SDFlash, if another 
port is selected by the system, you will need to change it so one of the mentioned ports is used:  

 

 

1 

2 

3 
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6. Click on Project →Settings… to open the Settings dialogue. Select the same com port as used in 
the device manager (COM1 → C1):  

 

 

7. Click on the “Erase” tab (1), and ensure that “User Options 1:” is set to “00ff” (2): 

 

 
 

8. Click on the “Programming” tab (1), then on the … button of the Flash Data File (2), double click on 
the FW folder (3), select the IMD.out file and click Open (4): 

2 

1 
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9. Click OK. 

 

 

Info 

If the com port or user option 1 was changed, you will be asked to save you 
project settings first, when attempting to upgrade the firmware in an IMD. 

2 

1 

3 

4 
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10. Click on Device → Flash… to open the upgrade dialogue: 

 

11. Ensure that all three checkboxes are ticked and click Start. 

12. When the programming cycle is completed, set the IMD back to normal operation mode: 

a. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) off.  

b. Set the CAN ID switch back to its original position. 

c. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) on. Note that the first 
startup after firmware upgrade might take longer (up to approximately 10 s).  

13. The IMD is now updated. 

4.1.2 Updating firmware for future CANopen update method 

Updating firmware with CANopen files, requires that a bootloader is installed as well. Once the 
bootloader is installed any future updates can be done remotely through CANopen.  

4.1.2.1 Prerequisites 

• A computer with Spectrum Digital SDFlash program installed (including V3.3 SDFlash serial patch 
for flash programming, September 5, 2008), (http://emulators.spectrumdigital.com/utilities/sdflash/) 

Typically, the necessary USB driver will be found automatically if the computer is on-line. Otherwise, 
go to Silicon Labs home page and download the latest driver for CP210x USB to UART Bridge 
(http://www.silabs.com/products/mcu/Pages/USBtoUARTBridgeVCPDrivers.aspx). 

• The computer must be connected to the IMD with USB cable (male type A to male type B). 

 

Info 

On rare occasions, The SDFlash program will show a “Connection error” after step 11 on 
page 15 is executed. In such a case, it is necessary to restart the whole process: 

1. Close the SDflash program 

2. Turn off the IMD 

3. Start the SDflash 

4. Turn on the IMD 

5. Repeat com configuration, and the actions described in steps 4 on page 12 to 13 on 
page 15 . 

 

Info 

The links above were valid at the time when this manual was written. If the link does 
not work anymore, search for  “V3.3 SDFlash serial patch” or “CP210x USB to 
UART Bridge driver”. 
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• Prepare the FW files for use.  

1. Copy the folder of the new FW. 

2. Paste the folder in the folder where other FW is located. If the FW files are located at their 
default location, go to myprojects folder in sdflash folder (where sdflash was installed) and 

paste the folder under myprojects. 

NOTE  The files can be located anywhere. It is possible to brows to the location and sdflash 
             remembers this location. 

3. Copy any of the .sdp files in the folder and paste it.  

4. Rename the .sdp file to the same name as the new FW folder: 

 

5. If there is no bootloader package in the folder, repeat the previous steps (1 to 4) for the 
bootloader: 

 

 

4.1.2.2 Updating CANopen bootloader file 

This task needs only to be done once, unless a newer bootloader version than the one already installed 
is available. 

1. Before turning the power to the IMD ON (24 V DC if the IMD does not have built-in power supply, or 
400 V AC if it does have a built-in power supply), ensure that the RFE input is OFF to prevent the 
IMD from starting the motor unintentionally. 

2. Connect the computer to the IMD Service connector with USB cable (male type A to male type B). 

3. Start the SDFlash if it is not started already. 
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4. Click File→Open Project… (1), select and select the .sdp file that belongs to the bootloader 
package that should be installed (2), and click Open (3):

 

 
 

5. Skip this step if the used Com port is known. 
Open the “Device manager” in the computer’s “Settings” and determine which com port is used for 
the USB connection (the look and name of the device manager may differ depending on the 
operating system). Only Com1, Com2, Com3, and Com4 can be used with the SDFlash, if another 
port is selected by the system, you will need to change it so one of the mentioned ports is used:  

 

 

1 

2 

3 
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6. Click on Project →Settings… to open the Settings dialogue. Select the same com port as used in 
the device manager (COM1 → C1):  

 

 

7. Click on Project →Settings… to open the Settings dialogue. 
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8. Click on the “Erase” tab (1), and ensure that “User Options 1:” is set to “0001” (2): 

 

 

NOTE  This step ensures that only the space allocated for the bootloader will be erased. 

2 

1 
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9. Click on the “Programming” tab (1), then on the … button of the Flash Data File (2), double click on 
the bootloader folder (3), select the IMD_bootloader.out file and click Open (4): 

 
 
 

10. Click OK. 

 

11. Set the IMD into programming mode by doing the following: 

a. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) off.  

b. Set the CAN ID switch to position 15. 

c. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) on. 

12. Click on Device → Flash… to open the upgrade dialogue: 

 

Info 

If the com port or user option 1 was changed, you will be asked to save you project 
settings first, when attempting to update the bootloader in an IMD. 

2 

1 

3 

4 
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13. Ensure that all three checkboxes are ticked and click Start.  

14. When the programming cycle is completed, click Close. 

15. Skip this step if the FW is to be update as well.  
Set the IMD back to normal operation mode: 

a. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) off.  

b. Set the CAN ID switch back to its original position. 

c. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) on. Note that the first 
startup after firmware upgrade might take longer (up to approximately 10 s).  

16. The IMD is now updated. 

4.1.2.3 Updating CANopen FW file 

This procedure describes how to update the IMD FW in an IMD prepared for CANopen FW update, 
through the Service USB connector. 

1. Skip this step if the SDFlash is started, and IMD is already turned on in programming mode  

a. Before turning the power to the IMD ON (24 V DC if the IMD does not have built-in power 
supply, or 400 V AC if it does have a built-in power supply), ensure that the RFE input is OFF to 
prevent the IMD from starting the motor unintentionally. 

b. Start the SDFlash if it is not started already. 

c. Set the IMD into programming mode by doing the following: 

i. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) off.  

ii. Set the CAN ID switch to position 15. 

iii. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) on. 

 

Info 

On rare occasions, The SDflash program will show a “Connection error” after step 11 on 
page 15 is executed. In such a case, it is necessary to restart the whole process: 

6. Close the SDflash program 

7. Turn off the IMD 

8. Start the SDflash 

9. Turn on the IMD 

10. Repeat com configuration, and the actions described in steps 4 on page 12 to 13 on 
page 15 . 
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2. Click File→Open Project… (1), select and select the .sdp file that belongs to the FW that should be 
installed (2) and click Open (3):

 

 
 

3. Skip this step if the used Com port is known. 
Open the “Device manager” in the computer’s “Settings” and determine which com port is used for 
the USB connection (the look and name of the device manager may differ depending on the 
operating system). Only Com1, Com2, Com3, and Com4 can be used with the SDFlash, if another 
port is selected by the system, you will need to change it so one of the mentioned ports is used:  

 

 

1 

2 

3 
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4. Click on Project →Settings… to open the Settings dialogue. Select the same com port as used in 
the device manager (COM1 → C1):  

 

 

5. Click on the “Erase” tab (1), and ensure that “User Options 1:” is set to “00fe” (2): 

 

 

NOTE  This step ensures that the bootloader already installed will not erased. 
 

6. Click on the “Programming” tab (1), then on the … button of the Flash Data File (2), double click on 
the FW folder (3), select the CoU_IMD.out file and click Open (4): 

2 

1 
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7. Click OK. 

 

 

Info 

If the com port or user option 1 was changed, you will be asked to save you 
project settings first, when attempting to upgrade the firmware in an IMD. 

2 

1 

3 
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8. Click on Device → Flash… to open the upgrade dialogue: 

 

9. Ensure that all three checkboxes are ticked and click Start. 

10. When the programming cycle is completed, set the IMD back to normal operation mode: 

a. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) off.  

b. Set the CAN ID switch back to its original position. 

c. Turn the 24 V DC (or the 400 V AC if the DC power supply is built-in) on. Note that the first 
startup after firmware upgrade might take longer (up to approximately 10 s).  

11. The IMD is now updated. 

 

4.2 Configuration 

This section describes how to configure the IMD with a customer specific configuration. 

4.2.1 Prerequisites 

Before it is possible to upload new parameters the IMD Manager must be installed on a windows 
computer (XP or newer). See IMD Manager installation instructions for details. 

• The configuration file (xxx.urf) is already made, and is available for the configuration. 

 

USB cable (male type A to male type B) must be at hand. 

1. Start the IMD Manager. 

 

Info 

On rare occasions, The SDFlash program will show a “Connection error” after step 11 on 
page 15 is executed. In such a case, it is necessary to restart the whole process: 

11. Close the SDflash program 

12. Turn off the IMD 

13. Start the SDflash 

14. Turn on the IMD 

15. Repeat com configuration, and the actions described in steps 4 on page 12 to 13 on 
page 15 . 
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2. Open the “Device manager” in the computer’s “Settings” and determine which com port is used for 
the USB connection (the look of the device manager may differ depending on the operating system). 
Only Com1 to Com 8 can be used, if another port is selected by the system, you will need to change 
it so one of the mentioned ports is used: 

 

 

3. Click Communication→Baudrate and verify that the baudrate is set to 115200: 

 
 

4. The IMD Manager is now ready. 

4.2.2 Configuring the IMD 

1. Before turning the power to the IMD ON, ensure that the RFE input is OFF to prevent the IMD from 
starting the motor unintentionally. 

2. Turn the power to the IMD on (24 V DC if the IMD does not have built-in power supply, 400 V AC if it 
does have a built-in power supply – configuring the charger requires 400 V AC).  

3. Connect the computer to the IMD Service connector.  

 

Info 

It is not possible to select the COM port in the IMD Manager before it is connected to an 
IMD. 
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4. In the IMD Manager, select the same com port as used in the device manager (if the IMD Manager 
remains turned on it is enough to do this only once): 

 
 

5. Ensure that the IMD is online by checking that “Drive is online” is shown at the bottom left of the 
IMD Manager (pos.1), and that RFE error is reported (pos.2), warnings can be ignored: 

 
 
 

1 

2 
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6. In the “Configuration 2/3” tab (1), upload the parameter file (xxx.urf) to the IMD by clicking on the 
“Load” icon in the “PC to/from running configuration” group box (2): 

 

 

7. Locate the configuration file and click “Open”: 

 
 

8. Wait a few seconds and you will see the parameters in the IMD Manager have changed. The new 
parameters are now uploaded to the IMD.  

1 

2 
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9. In the “IMD (axis) name” group, enter a name (maximum 4 characters) for the IMD according to the 
customer specific documentation (this step is optional): 

 

10. In the “Save running configuration to EEPROM”, click on the “To startup” icon to save the new 
configuration to the EEPROM of the drive and be used in the next power up.  

 
 

11. The IMD is now configured with the customer specific parameters. 
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5. Installation verification 

Verification of the installation can be done in various ways, and is also depended on where the 
verification is done and how many of the interfaces are connected to the IMD at the time of verification.  

This section describes a way to verify the installation, though it cannot be a complete description since 
this will depend on the application in the specific turbine, as well as the situation in which the installation 
is verified.  

It is recommended to perform the verification of the installation described in this section before shipping 
the electrical/pitch system from the production. For troubleshooting see section 6 on page 47. 

The verification is described as one list of tasks, which is broken into functional groups. Tasks, not 
deemed to be relevant can be omitted. Other tasks need to be further defined in details (for example, 
which digital inputs to test and how to change the level of these), consult the applicable verification/test 
information.  

5.1 Prerequisites 

The described procedure requires the following: 

• The IMD is fully installed with all connections to the motor, brake, resolver, limit switches and so on 

• It must be possible to turn the RFE input ON and OFF in order to perform the verification 

• It must be possible to turn any used connections to digital inputs on and off, if full verification is 
required  

• The IMD firmware is updated if necessary 

• The IMD is configured with customer specific parameters 

• A computer with IMD Manager installed and running 

5.2 Verification 

 

Danger! 

Risk of burns and electrical shock from short circuit, electrical arc and uninsulated wires or 
terminals. 

This verification procedure requires work with live circuit with voltage up to 860 V DC and 
400 V AC, and may only be carried out by skilled personnel.  

When the IMD has been powered, there is a risk of stored energy even when the power is 
disconnected. Wait 5 minutes after the power is disconnected and verify zero energy 
according to company procedures on the outputs before performing any work. 

 

 

 

Caution! 

Danger of hand and limb crush from to moving objects.  
Be careful when the motor or other mechanical parts are moving.  
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5.2.1 Turning on power and checking errors 

 

Attention 

It is important that the Mains (400 V AC) is turned on before the safe energy is connected in 
order to prevent damage to internal power components. See also section 3 on page 8 for 
information about how to avoid damaging the IMD. 

 

1.  Before turning the power to the IMD ON, ensure that the RFE input is OFF to prevent the IMD from 
 starting the motor unintentionally. Ensure that the safe energy is turned OFF.  

2. Ensure that at least one limit switch is activated. 

3. Turn the power to the IMD on (24 V DC if the IMD does not have built-in power supply, or 400 V AC 
if it does have a built-in power supply).  

4. Connect the computer to the IMD Service connector. Ensure that the IMD is online by checking that 
“Drive is online” is shown at the bottom left of the IMD Manager (pos.1). It is assumed that the COM 
port in the IMD Manager is already configured (from the IMD configuration step 4 on page 27 ) 
Click on “Clear errors” (pos.2) and verify that only RFE error is reported (pos.3). If any other errors 
or warnings are shown, evaluate whether they should be shown due to missing inputs/sensors or 
AC power (see section Error! Reference source not found. on page Error! Bookmark not 
defined.) : 

 

5. Verify that at least one limit switch is on (does not matter whether it is Lim.sw 1 or Lim.sw 2): 

1 2 

3 
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5.2.2 Verifying safety-chain inputs and motor control function 

6. If the 400 V AC supply is not turned on already, turn it on. 

7. Ensure that the signal to RUN input is high.  

8. Activate RFE, click on “Clear errors” button, verify that the “RFE open” error is not shown anymore. 

9. Reset the safety-chain. 

10. Click on “Monitor and control” tab. Verify that both SCI 1 and SCI 2 (safety-chain inputs) are on: 

 

 

Info 

If no limit switch is activated when the IMD starts or shortly after (depending on the 
configured safety-run timeout) the IMD will enter an error state where enabling the device 
will not be possible. 

http://www.deifwindpower.com/


IMD 100 Configuration and verification instructions 4189360016 Rev. C Installation verification 

 

www.deifwindpower.com Page 33 of 60 

11. Enter 1000 in the Test→Speed field: 

 

12. Click on “Enable dev.” button. Verify that it changes to green. 

  

13. Verify that the Dev.Enabled LED has changed to green. 
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14. Click on “+” button, verify that the motor turns (RPM changes to a non-zero value and the motor can 
be heard turning) 

 

5.2.3 Verifying safe energy connection 

NOTE   Skip this section if no safe energy source is connected to X1. 
  

15. While the motor is still turning, disconnect the mains by selecting “12:Maines, disconnect” in the 
“Special commands” in the “States and special commands” group: 

 
  

16. Verify that the motor continues to turn. 

 

Attention 

Pay attention to the RPM. Disable the drive (click on the “Enable dev.” button ) 
if the motor starts racing away or is unstable in any other way. 
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17. Reconnect the mains by selecting “13:Maines, connect” in the “Special commands” in the “States 
and special commands” group: 

 

18. If the SEM connector is connected to the mid-point of the safe energy, verify that the shown voltage 
is plausible. 

 

5.2.4 Verifying SSI function 

Prerequisites: The SSI encoder and motor must be mechanically connected. 

19. While the motor is turning click on “Monitor and control” tab (pos.1), verify that the number in the 
Reg. value (pos.2) of the SSI encoder is changing: 

 
 

5.2.5 Verifying resolver function 

20. While the motor is turning click on “Monitor and control” tab (pos.1), verify that the number in the 
Reg. value (pos.2) of the resolver is changing: 

 

2 

  

1 

  

2 

  

1 
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5.2.6 Verifying motor temperature connection 

21. Click on the “Monitor and control” tab and observe “T-motor” in the “Temperature” group. 

 

22. For KTY84 and PT100, verify that the value (in units) for the motor temperature is plausible. Use the 
following chart to estimate the value: 

 

 

 

Info 

This check is not meant as a test of the sensor’s accuracy. A plausible value is ± 20 Cº 
within the estimated temperature.  A value above 30000 most likely means that there is no 
sensor connected to the temperature input. 
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If a PTC temperature sensor is used, verify that that the T-motor is between the following values 
(assuming normal working temperature): 

Number of PTCs in series Raw values 

1 100 to 7800 

3 100 to 28800 

 

5.2.7 Verifying limit switches function 

23. Ensure that when the limit switches LED icons change state when they are activated (it depends on 
the specific application whether the limit switches are N.O or N.C): 

 

5.2.8 Verifying digital inputs 

Prerequisites: In order to be able to verify a digital input it must be possible to change the input level of 
the interface connected to the digital input. 

24. Click on the “Monitor and control” tab (1). Observe the “Digital inputs” group (2). 
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25. Change the level of the interface of a digital input and verify that the LED indication for that input 
changes accordingly. 

5.2.9 Verifying temperature sensors (Pt100) functions 

26. Click on the “Monitor and control” tab and observe “Pt100-x” in the “Temperature” group. 

 

27. Verify that the values (in units) for the connected sensors are plausible. Note that the values given 
are in 12 bits resolution. Use the following chart to estimate the value: 

1 

  

2 
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Info 

This check is not meant as a test of the sensor’s accuracy. A plausible value is ± 20 Cº 
within the estimated temperature. A value above 4000 most likely means that there is no 
sensor connected to the temperature input. 
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5.2.10 Verifying the fan function 

The fan function is verified differently depending on the IMD HW version. 

5.2.10.1 Verifying the fan function – IMD 122/135 C 

28. Select “17:Fan ON” in the “States and special commands” in the “Monitor and control” tab.  
The IMD turns the fan on. 

  

29. Verify that the fan at the back of the IMD (outside the cabinet) is turning and does not make an 
unusual noise (for example if the cover touches the fan), and that the fan’s wind direction is into the 
heatsink. 

30. Select “18:Fan Auto” in the “States and special commands” in the “Monitor and control” tab. The fan 
will be back to automatic control. 

  

 

 

 

Info 

The description in this section only applies to IMD122/135 C. 

Description for IMD122 B can be found in section 5.2.10.2 on page 41. 
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5.2.10.2 Verifying the fan function – IMD 122B 

 

31. Click on “Configuration 1/3” tab (1). Select “—Off—” as Operand 1 for “Logic-8=>Do8” (2): 

 

  

 

Info 

The description in this section only applies to IMD122 B.   

This description is valid when the fan is connected to DO8 (see IMD 100 installation 
instructions). 

Description for IMD 122/135 C can be found in section 5.2.10.1 on page 40. 

1 

  

2 

  

http://www.deifwindpower.com/


IMD 100 Configuration and verification instructions 4189360016 Rev. C Installation verification 

 

www.deifwindpower.com Page 42 of 60 

32. Click on the “Monitor and control” tab (1). Click on “Do 8” button (2) to turn the fan on (if another 
output was used for the fan, click on the corresponding icon). 

  

33. Verify that the fan at the back of the IMD (outside the cabinet) is turning and does not make an 
unusual noise (for example if the cover touches the fan), and that the fan’s wind direction is into the 
heatsink. 

34. Click again on “Do 8” button on the “Monitor and control” tab, to turn the fan OFF. It is not necessary 
to put the “Logic-8=>Do8” settings in the Logic tab back. When the settings are not saved, the 
original settings will be restored when the IMD starts again. 

5.2.11 Verifying digital outputs 

The digital outputs can be manually turned on and off in the “Digital outputs” group in the “Monitor and 
control” tab.  

35. Do 5 to Do 8, might be mapped to from the “Logic” group in the “Configuration 1/3) tab. In such a 
case, disable the mapping: Click on “Configuration 1/3” tab and select “—Off—” as operand 1 for the 
appropriate logic output.  
122 B only: If any logical output was configured for the fan, reconfigure that output for the fan 
operation.  

36. Click on the button for the relevant output to turn it on or off. 

5.2.12 Verifying safety-chain output (SCR) 

It is assumed that the emergency stop switch is connected to RFE input. 

1 

  

2 
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37. Verify that SCR 1 and 2 is on: 

  

38. Activate the emergency stop switch. Verify that SCR 1 and 2 is turned off. Verify (depending on the 
specific function of SCR 1 and SCR 2 in the turbine) that the safety chain signal is turned off 
(verification of the wiring to X8-7 to X8-10). 

 

5.2.13 Verifying CAN/CANopen communication 

39. Verify in the “Monitor & control”, “Reg. 0x9B flags” group that the CAN ID switch on the IMD front 
panel is sat to the correct position according to the documentation: 
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40. Ensure that the application SW is running. Pull out the CAN communication cable from X6. 
Verify that a BUS TIMEOUT error appears in the Error(s) field in the IMD Manager: 

 

5.2.14 Verifying manual operation 

NOTE   Skip this section if no manual operation is used for the IMD (no connections to X9 terminals 15, 
16 and 17). 

41. Set “VLMS-low” and “VLMS-high” to zero in “Configuration 1/3”, “Virtual limit switches” group (if not 
already configured to zero): 

 

42. Verify that Man. operation is enabled in “Configuration 1/3”, “Manual operation” group: 

 

43. Set the switch connected to X9/17 (DI 12) ON. 

44. Activate the switch connected to X9/15 (DI 10). Verify that the motor is turning.  
Deactivate the switch. 

45. Activate the switch connected to X9/16 (DI 10). Verify that the motor is turning the other way.  
Deactivate the switch. 

46. If virtual limit switches are used and a switch is connected to X9/14 (DI 9), verify manual operation 
360: 

a. Verify that “Man.oper.360” is disabled in “Configuration 1/3”, “Manual operation” group: 
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b. Set “VLMS-low” and “VLMS-high” to the same value as the “Actual position” in “Configuration 1/3”, 
“Virtual limit switches” group: 

 

c. Activate the switch connected to X9/15 (DI 10). Verify that the motor is turning only one revolution and 
then stops.  
Deactivate the switch. 

d.  Enable “Man.oper.360” is disabled in “Configuration 1/3”, “Manual operation” group: 

   

e. Set the switch connected to X9/14 (DI 9) ON. 

f. Activate the switch connected to X9/15 (DI 10). Verify that the motor is turning.  
Deactivate the switch. 

g. Set the switch connected to X9/14 (DI 9) OFF. 

47. Set the switch connected to X9/17 (DI 12) OFF.  

5.2.15 Verifying 24 V DC output (IMD with internal power supply option only) 

NOTE   Skip this section if no external load is connected to X7. 

48. If there is an external power supply (backup) connected to X7, switch the power supply OFF. 

49. Measure voltage with a voltmeter on X7/1 and X7/4 and verify 24 ± 2.5 V DC. 

50. If an external power supply was switched OFF, switch it ON again. 

5.2.16 Verifying Safe Energy charger (IMD with built-in charger option only) 

NOTE   Skip this section if there is no charger in the IMD, or if no safe energy source is connected to 
X1. 

51. Click on the “SE charger” tab in the IMD Manager. 

52. Verify that the charging process (green LED) is not in disabled stage (must be in either Bulk, 
Absorption, or Float stages). The following example is from an Ultra-capacitor SE type: 
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53. Lead acid batteries only: If temperature compensation is used, verify that the temperature shown in 
the “Measurements” group is plausible: 

 

5.2.17 Verification completion 

54. Turn off the power to the IMD. The verification is now complete.  
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6. Troubleshooting 

 

Problem Possible causes Remedy 

“Enable dev.” button does not 
turn green  

• An error is still active 

• Safety-chain inputs (SCI 1 
and SCI 2) are not correct 

• Remove error cause and 
click “Clear errors” button 

• Check wiring from the 
safety-chain 

Dev. Enabled is not on (green) • Either RUN (X9-2) is not 
high or an error is active  

• Remove error cause and 
click “Clear errors” button 

• Check RUN connection 

Motor doesn’t move  

Motor turns the wrong way 

“RACEAWAY” error is shown 

• Wiring to the motor is wrong • Check the wiring between 
the motor and the IMD 

Motor doesn’t move on SE • One or both wires to SE are 
defective or not connected 

• The SE is not charged  

• A cell is defective 

• Check the SE wires 

• Check if the SE source is 
charged 

• Check if all cells are OK. 
Testing the cells must be 
performed with load. 

SSI doesn’t show movement 
when the motor is turning. 

• Connection to the SSI 
sensor is bad  

• The SSI sensor doesn’t 
work. 

• Check the wiring to the SSI 
sensor 

• Replace the sensor  

Resolver value doesn’t show 
movement when the motor is 
turning. 

• Connection to the resolver 
is bad  

• The resolver doesn’t work. 

• Check the wiring to the 
resolver 

• If necessary, replace the 
resolver  

Motor temperature does not 
show right temperature 

• The wrong sensor is 
configured as motor temp. 
sensor 

• The connection to the 
sensor is bad 

• Configure the correct sensor 
(KTY or PT100) 

• Check the wiring to the 
sensor 

Lim.sw x does not change state • Bad connection in the limit 
switch or X9 

• 0 V is missing in X9 

• Limit switch is defect 

• Check the wiring 

• Check the wiring (X9-9/18) 

• Replace the limit switch 

DI x does not change state • Bad connection 

• 0 V is missing in X9 

• Check the wiring 

• Check the wiring (X9-9/18) 
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Problem Possible causes Remedy 

Temperature sensor does not 
show right temperature 

• The wrong sensor is used 
(not Pt100) 

• The connection to the 
sensor is bad 

• Use the correct sensor 

• Check the wiring to the 
sensor 

Fan doesn’t work • Wrong wiring to the fan 

• The fan cover is bent 

• Check the wiring to the fan 

• Replace or straighten the 
fan cover 

Digital output does not work • Bad connection 

• 0 V or 24 V is missing in X8 

• Check the wiring 

• Check the wiring (X8-11/20) 

CAN communication does not 
work 

• CAN ID is not correct 

• Wiring or termination is 
wrong 

• IMD is using wrong 
communication speed 

• Set the CAN ID switch in the 
correct position.  

• Check in the CAN 
parameters in 
“Configuration 1/3” tab that 
the Rx and Tx IDs are 
correct 

• Check the wiring and 
termination resistors 

• Check in the CAN 
parameters in 
“Configuration 1/3” tab that 
NBT is sat to the correct 
speed 

Safety run timeout • No limit switch is defined as 
Ref Plus 

• Bad or wrong connection to 
the limit switch 

• The limit switch is defective 

• Check that Limit S. 1 or 
Limit S. 2 is defined as Ref 
Plus in the in “Configuration 
1/3” tab, “Input function”   

• Check the wiring to the limit 
switch 

• Replace the limit switch if 
necessary 

Charger not charging 

(IMD 122C or later mounted 
with SE charger option) 

• The IMD is not equipped 
with the charger option 

• No safe energy source is 
connected, wrong polarity, 
or defective wire  

• No valid SE charger 
configuration 

• The charger is in Setup 
mode 

• Check on the label that the 
SE Charger is included in 
the options. 

• Check wiring to the safe 
energy source 

• Check in the IMD manager 
that the charger 
configuration is valid 

• Check in the IMD manager 
that the charger is not in 
Setup mode 
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7. Errors and warnings 

The IMD has two ways to report faults: Errors and warnings: 

 Cause and action Reset 

Warning Normal parameter limits are beginning 
to be crossed. No immediate action.  

If not addressed, some warnings might 
escalate to errors after a timeout. 

Automatically reset when the cause is 
removed. 

Error Severe violation of limits, causing a 
safety chain trip, and either an 
immediate motor stop or initiating a 
safety run. 

Reset is done either from the controller, 
another USB device, or using the IMD 
Manager tool.  

From the application SW or another USB 
device, writing any value to register 0x8E 
resets errors. 

Reset is not possible if the cause is not 
removed. 

Both errors and warnings are displayed on the IMD display and the IMD Manager tool. 

7.1 Error list 

When an error is active it is displayed in the IMD Manager tool in the “Error(s)” field. Following is a list 
of errors:  

Table 1 Error list and description 

IMD 
display 
/ Error 
bit no. 

IMD Manager 
Error(s) field 

Safety run 
performed 

Error description 

0 BADPARAS No 
Checksum (CRC) error when reading parameters 
from EEPROM. This error can only be reset by a 
power-cycle (OFF-ON) of the IMD. 

1 POWER FAULT No 
A fault condition related to the IGBT module is 
detected.  

2 RFE open No RFE (Rotational Field Enable) input is in low state.  

3 BUS TIMEOUT Yes 

This error can be caused by three reasons: 

• Timeout has occurred on the CAN-bus. Timeout 
period defined in ms in register CAN_TIMEOUT 
(0xd0). The bus time out error is enabled after 
the CAN bus has reached operational state. 

• Communication error with the built-in charger 
(after the communication was initialised at start-
up). 

• Communication error with the built-in charger 
(option). When resulting from this reason, the 
error is generated automatically after warning 3 
has been active during the Charger timeout 
period and not cleared.  
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IMD 
display 
/ Error 
bit no. 

IMD Manager 
Error(s) field 

Safety run 
performed 

Error description 

4 FEEDBACK Yes 
Bad or no motor feedback signal. The resolver 
circuit detects a fault.  

5 UNDERVOLTAGE No 
DC link voltage is lower than DC-link Vlow or DC-link 
Vmin.  

6 MOTORTEMP Yes 

Motor temperature too high. Motor-temperature 
reached the limit specified in M-temp.  
This error can be reset after the motor had cooled 
down. 

7 DEVICETEMP Yes 
IMD temperature too high.  
This error can be reset after the IMD had cooled 
down. 

8 OVERVOLTAGE Yes/No 
DC-link voltage upper limits (HW DC-link 
overvoltage or DC-link Vmax) exceeded.  

9 I_PEAK No 
The current to the motor exceeded the peak current 
limit for more than 8 ms.  

A MOTOR OUTPUT No 

The motor speed and direction cannot be controlled. 
The motor either races at full speed or cannot move. 
This error can be caused by four reasons: 

• Non coherent parameter configuration. 

• Mismatch between the direction from the drive 
and direction from the motor feedback. 

• The phase sequence (W, V, U) is wrong. 

• At least one of the phases from the IMD to the 
motor is disconnected. 

B CHARGER  

Error in the charger (option). This error is generated 
automatically after warning B has been active during 
the Charger timeout period and not cleared. 

There are a number of charger errors that caused 
the warning that was escalated to the error. Possible 
errors are listed in section 7.1.1 on page 51. The 
active errors can be determined by reading the 
charger error register. 

C HIGHVOLTAGE Yes 
HIGHVOLTAGE warning was on more than 
approximately five seconds. 

D PRE_CHARGE Yes 
Pre-charge circuit failure. Mains power cannot be 
connected to DC link. 
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IMD 
display 
/ Error 
bit no. 

IMD Manager 
Error(s) field 

Safety run 
performed 

Error description 

E HW-ERROR 

No 

Hardware component failure. Multiple reasons can 
cause this error. For example: 

• An internal supply voltage has failed 

• Internal communication to power-module has 
timed out 

• The controller has detected a power-module 
error-condition 

• The internal current measurement has failed 

Determination of the precise reason can only be 
done by experts, possibly also using the errors log. 

 

F 
BALLAST Yes 

This error can be caused by two reasons: 

• Ballast resistor overload. The ballast resistor 
load has exceeded the configured value (Ballast-
P). This error can be reset after a timeout has 
elapsed. 

• Hardware failure in the ballast circuit or resistor 

7.1.1 Charger (option) errors 

If the built-in charger option is mounted in the IMD, the following errors can be read from the charger 
warnings register: 

Error 
bit no. 

Error text Error description 

0 OPENCIRCUIT 
The charger detected open circuit. No safe energy source is 
connected, or a wire is broken. 

1 SHORTCIRCUIT 

The SE output is short-circuited.  

For lead acid this error is raised when the SE voltage is less than 
20% of nominal while charging. 

2 CHARGERTEMP The internal temperature of the charger is too high. 
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7.2 Warning list 

When a warning is active it is displayed in the IMD Manager tool in the “Warning(s)” field. Following is a 
list of warnings:  

Table 2 Warning list and description 

Warning 
bit no. 

IMD Manager 
Warning(s) field 

Warning description 

0 BADPARA 

Parameter error. This warning can be caused by the following 
reasons: 

• Deceleration ramp too long when “Run” signal is deactivated 

• Calculation of motor-parameters gives an unlikely result 

1 Warning 1 Not used 

2 Warning 2 Not used 

3 COMCHARGER 

Communication error with the built-in charger (option).  

If this warning persists for the Charger timeout period, and the 
IMD is configured to escalate charger warnings to error, error 
3 will be generated. 

Sending “clear errors” every 8 seconds will delay error 
generation (until clearing errors is stopped) if the warning 
persists. 

4 FEEDBACK 
Unstable resolver signal. This warning is also active during blind 
safety run. 

5 POWERVOLTAGE Safe energy voltage is lower than SE Vmin. 

6 MOTORTEMP 
--Motor temperature high. Motor-temperature reached 87.5% of the 
limit specified in M-temp. 

7 DEVICETEMP 
IMD temperature high.  
Internal components temperature exceeded 72 ºC.  

8 Warning 8 Not used 

9 I_PEAK Digital output driver is overheated 

A Warning A Not used 

B CHARGER 

Error in the charger (option).  

There are a number of charger errors that caused the warning that 
was escalated to the error. These can be determined by reading the 
charger error register. 

If this warning persists for the Charger timeout period, and the IMD 
is configured to escalate charger warnings to error, error 3 will be 
generated. 

Sending “clear errors” every 8 seconds will delay error generation 
(until clearing errors is stopped) if the warning persists. 

C HIGHVOLTAGE 
Ballast resistor is on too long (> 100 ms) while the Mains is ON. If 
the pitch controller does not act for more than 5 seconds, a 
HIGHVOLTAGE error is generated, and the warning is reset. 

D Warning D Not used 
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Warning 
bit no. 

IMD Manager 
Warning(s) field 

Warning description 

E HW-warning 

This warning can be caused by the following reasons: 

• Current offset too high (too far from zero) 

• Pt100 measurements are wrong, measured value cannot be 
trusted 

• DI 10, 11 or 12 is high when not in manual operation mode (and 
manual mode is enabled). 

F BALLAST 
The ballast resistor load is over 50% the configured maximum 
value.  

7.2.1 Charger (option) warnings  

If the built-in charger option is mounted in the IMD, the following warnings can be read from the charger 
warnings register: 

Warning 
bit no. 

Warning text Description 

0 BATTEMP 
The battery temperature is more than 10ºC outside charging 
temperature limits (-20ºC to 50ºC). Lead acid only. 

1 TEMPCHANNEL The defined temperature sensor channel is not valid. 

2 VinLOW The input voltage from the DC-link is below 270 V DC. 

3 Vin-VseLOW 
The input voltage from the DC-link is not at least 15 V DC higher 
than the SE voltage. 

4 LOWCURR. The output current is too low compared to setpoint. 

 

7.3 Errors log 

The IMD has an error log containing up to 20 entries. The log is a rolling log using “First In First Out” 
principle, which means that it always contain the latest 20 errors generated by the IMD, with the latest 
error at the top. The log entries are available in the IMD Manager and through CAN/CANopen. Each 
entry contains the following parameter values at the time the error occurred (see description of the 
register in the Integration manual for details): 

Information Register Description 

IMD state 0x02 The state of the IMD  

T-IGBT 0x4A The numeric representation of the IGBT temperature 

N act (filt) 0xA8 The filtered actual speed value in units 

N cmd ramp  0x32 Speed command after ramp in units 

I act (filt) 0x5F Actual filtered current value in units 

DC-link voltage 0xEB The filtered voltage of the DC-link in units 

Drive status 0x40 Bit map representation of the state of the internal flags 
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Information Register Description 

Logic in block 0x9B Bit map representation of the state of digital inputs and some 
internal flags 

Out block 0x98 Bit map representation of the state of digital outputs 

Power board 
status 

0x63 Status of the power board 

Actual current limit 0x48 The current limit used at the time 

Special command 0x03 The values of the special commands register. If a command was 
executed, the register contains the feedback for the command. 

Error register value 0x8F Active errors at the time the error occurred 

ID N/A Special ID information for the error 

Timestamp 1 
(Device enabled) 

N/A A relative time stamp (seconds) for the entry indicating the time 
elapsed since the last time the device enabled flag was set 

Timestamp 2 
(power) 

N/A A relative time stamp (seconds) for the entry indicating the time 
elapsed since the last power on of the IMD 

Timestamp 3 (life) N/A A relative time stamp (seconds) for the entry indicating the time 
elapsed since the IMD was delivered from the factory, or if the IMD 
is older, since the first time a firmware supporting error history was 
installed. This time counter only counts time when the IMD 24 V 
DC supply (external or internal) is on. 

For IMDs that were delivered with FW older than 1-08-0 (first FW 
with error log) the life time stamp is relative to the time when the 
first FW supporting error log was installed on the IMD. 

 

The last error further contains the following parameter values at the time the error occurred (Extra info):  

Information Register Description 

Actual position 0x6D The actual position based on the resolver and rounds count 

Actual position SSI 0x6F The actual position based on the SSI encoder count 

1st error in power 
board 

0x94 First error (code) on power board since last clear error command. 

Ballast energy 
counter (L) and 
Current overload 
integral (H) 

0x45 Values of Ballast energy counter (low 16 bits), Current overload 
integral (High16 bits),  

SE voltage 0x66 Numeric value of the safe energy voltage 

SE mid-point 
voltage 

0x61 Numeric value of the safe energy mid-point voltage 

T-air 0x4B Numeric value of the air temperature inside the IMD 

(dbg) *temp 0x9A Dynamic pointer register used for debug by DEIF engineers 

(dbg) *ptr1 0xB8 Dynamic pointer register used for debug by DEIF engineers 

(dbg) *ptr2 0xBA Dynamic pointer register used for debug by DEIF engineers 

(dbg)  ptr1 0xB7 Dynamic pointer register used for debug by DEIF engineers 
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Information Register Description 

(dbg)  ptr2 0xB9 Dynamic pointer register used for debug by DEIF engineers 

 

The error log also contains a distribution representation of all errors occurred during the “Elapsed 
time:life” (the time elapsed since the first FW supporting error history was installed), showing how many 
times each error appears in the log:  

  

 

 

  

http://www.deifwindpower.com/


IMD 100 Configuration and verification instructions 4189360016 Rev. C Revision history 

 

www.deifwindpower.com Page 56 of 60 

8. Revision history 

Apart from editorial changes the following changes have been made in this revision: 

Date Revision Changes 

2020-09-25 C • “Firmware update” section in “Configuration and firmware update” 
updated 

• “Turning on power and checking errors” updated 

• “Connecting the safe energy” in “Avoiding damage to the IMD” updated 

• “Charger (option) warning” in “Warning list” updated 

2019-06-29 B • Based on IMD Manager version 1.0.5.0 

• Referenced documents section added 

• Error and warning lists updated 

• Screen pictures updated 

• Ny procedure for SSI encoder and resolver verification 

• New procedure for PTC temperature sensor 

• New procedure for fan verification in C version 

• New procedures for verifying manual operation, 24 V DC output, SE 
charger, and SE measurements 

• “Error and warning lists” section renamed to “Errors and warnings” 

• “Errors and warnings log” section added to “Errors and warnings” 
section 

• Troubleshooting updated 

2016-12-22 A This is the first version of the document. This manual is based on IMD 
Manager version 1.0.0.0. 
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9. Product user documentation 

The IMD product has an extensive user documentation, targeted towards different audience and 

product use stages.  

The following documents are part of the user documentation:  

Table 3 IMD user documentation 

Document Target audience Content 

IMD 100 datasheet 

Document no.: 

4921260015 

Buyers and technicians of 
customers 

Describes relevant specifications and give an overview 
of the IMD functions 

IMD 100 function 

description 

Document no.: 

4189360013  

Mainly technicians and 
engineers of customers. 

Describes the functions of the IMD. Gives the reader an 
understanding of the purpose of the IMD in a system, 
and which functions can be utilised in a pitch system. 
The functions are described so that the reader can 
understand what each function is used for. 

IMD 100 integration 

manual  

Document no.: 

4189360015 

Engineers at customer 
R&D department 

Describes how to integrate the IMD in a pitch system. 
Gives extensive knowledge about: 

IMD SW (parameters and how to achieve specific 

functionality) 

How to create customized parameter file for use in 

production 

Requirements for external interfaces/components 

IMD Manager 
installation 
instructions 
Document no.: 
4189360018 

Engineers at customer 
R&D department, as well 
as commissioners and 
service personnel 

Describes how to install the IMD Manager.  
The IMD Manager is an application used to configure 
and control the IMD using the Service USB connector. 

IMD Manager user 

manual  

Document no.: 

4189360019 

Engineers at customer 
R&D department, as well 
as commissioners and 
service personnel 

Describes how to use the IMD Manager.  
The IMD Manager is an application used to configure 
and control the IMD using the Service USB connector. 

IMD 100 installation 
instructions 
Document no.: 
4189360005 

Technicians at production 
site where the IMD is 
mounted in the cabinet/hub 

Describes how to mount, connect and perform initial 
start, test, and configuration (using a configuration file) 
of the IMD at production. 

IMD 100 initial 

configuration and 

verification manual 

Document no.: 

4189360016 

Commissioners or other 
personnel with similar 
qualifications, as well as 
service personnel (for SW 
upgrade) 

Describes how to upgrade the IMD SW, how to load 
configuration file, and how to verify the IMD installation 
to the possible extent. 
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Document Target audience Content 

IMD 100 service and 

maintenance manual 

Document no.: 

4189360017 

Service and warehouse 
personnel 

Describes preventive (scheduled) and corrective 
maintenance of the IMD, as well as storage 
requirements. 

IMD 100 installation 

checklist 

Document no.: 
4189360021 

Technicians at production 
site where the IMD is 
mounted in the cabinet/hub 

Installation tasks with check boxes to document the 
tasks done during installation 

IMD 100 

configuration and 

verification checklist 

Document no.: 
4189360022 

Commissioners or other 
personnel with similar 
qualifications, as well as 
service personnel (for SW 
upgrade) 

configuration and verification tasks with check boxes to 
document the tasks done during configuration and 
verification 

Addendum to 

installation manual 

Document no.: 
4189360023 

Integration and installation 
personnel 

Describes the how to replace a pitch drive when the IMD 
is equipped with Retrofit wiring harness var.1 

 

The IMD 100 documentation is written anticipating an OEM (original equipment manufacturer) product 
use-cycle in a wind turbine. The envisioned cycle is described in the following figure. The description 
also explains the tasks, who is expected to execute the task, the location where the execution takes 
place and the supporting DEIF documentation for the task. Many details in these tasks depends on the 
actual implementation, which is why the IMD documentation will never stand alone. 
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1. IMD evaluation 
and purchase

• Task: Evaluation of the IMD

• Who: Customer buyers and 
engineers

• Supporting DEIF documents:

• Datasheet

• Function description

2. IMD integration 
in the customer’s  

product

• Task: Integrate the IMD in the turbine 
systems.

• Who: Customers R&D. 

• Where: Customers facility

• Output:

• Wiring diagram

• Cabinets specifications

• IMD configuration file

• Controller application SW (not IMD 
scope)

• Supporting DEIF documents:

• Datasheet

• Function description

• Integration manual

• Addendum to installation manual

• IMD Manager Installation 
instructions

• IMD Manager user manual

3. Installation

• Task: Install the IMD in the cabinet, 
install the cabinet in the hub.

• Who: Installation personnel.

• Where: Customer’s production 
facility.

• Supporting DEIF documents:

• Installation manual

• Installation check list

• Addendum to installation manual 

4. Initial 
configuration and 

verification

• Task:

• Upgrade the IMD SW if needed

• Configure the IMD with the 
configuration file

• Test the IMD installation

• Who: Commissioning or similar 
personnel. 

• Where: Customer’s production 
facility

• Supporting DEIF documents:

• Initial configuration and 
verification manual

• Configuration and verification 
check list

• IMD Manager Installation 
instructions

• IMD Manager user manual

5. Commissioning 
on site

• Task: Commission the whole 
turbine

• Who: Commissioning personnel

• Where: Turbine erection site

• Supporting DEIF documents:

• None. This task is entirely 
customer’s task based on 
customer’s documentation

6. Service and 
maintenance

• Task:

• Service of the IMD

• Replacement (disposal) of IMD

• Storage of spare parts

• Who: Service and warehouse 
personnel.

• Supporting DEIF documents:

• Service and maintenance 
manual

• IMD Manager Installation 
instructions

• IMD Manager user manual

 

Figure 2 Tasks and documentation overview 
 

The described product use-cycle might not apply as is for all customers, but the tasks are universal and 
can therefore be adapted. For example, if the SW upgrade, configuration and verification is done during 
the turbine commissioning, the applicable documentation can be used at this stage instead of a 
separate stage at the end of production. 
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10. Glossary 

10.1 Terms and abbreviations 

CAN Controller Area Network (communication protocol) 

IMD Integrated Motor Drive  

SCI Safety-Chain Input 

SCR Safety-Chain Relay 

SE Safe Energy 

SSI Synchronous Serial Interface 

USB Universal Serial Bus 

10.2 Units 

Unit Unit 
Name 

Quantity name US 
unit 

US name Conversion Alternative 
units 

A ampere Current     

ºC degrees 
Celsius 

Temperature ºF Fahrenheit 𝑇[º𝐶]  

=  
(𝑇[º𝐹]  −  32 º)  × 5

9
 

 

g gram Weight oz ounce 1 g = 0.03527 oz  

Hz hertz Frequency (cycles 
per second) 

    

kg kilogram Weight lb pound 1 kg = 2.205 lb  

m metre length ft foot (or feet) 1 m = 3.28 ft  

mA milliampere Current     

mm millimetre Length in inch 1 mm = 0.0394 in  

ms millisecond Time     

RPM revolutions 
per minute 

Frequency of 
rotation (rotational 
speed) 

    

s second Time     

V volt Voltage     

V AC volt 
(alternating 
current) 

Voltage 
(alternating 
current) 

    

V DC volt (direct 
current) 

Voltage (direct 
current) 

    

W watt Power     

Ω ohm Resistance     
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